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Relinking the lesson files

It is possible that the file path to the lesson files may need to be updated. If you open an Ado-
be Premiere Pro project and it cannot find a media file, the Link Media dialog may open and 
ask you to relink offline files. If this happens, you will need to navigate to one of the offline 
files in order to reconnect. Once you’ve reconnected one file in the project, the rest should 
reconnect.
Click the Locate button and use the browser to locate an offline clip. You can navigate to the 
same location where you copied the files you downloaded. If you stored your lesson files 
in the location we suggest, the path should be Desktop > Lessons > Assets. You may need 
to look in some of the included folders to find the media file (especially if it involves tape-
less media). You can also navigate to the Lessons folder and click the Search button to have 
Adobe Premiere Pro search for the file. When you locate a file, just select it and click the 
OK button. For more information on this process, see “Using the Link Media panel and the 
Locate command” in Chapter 17.[live link?]
For more information on working with these files, go to the section How to use these lessons 
in “Getting Started” at the front of the book. 
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Adobe Premiere Pro CC, the essential editing tool for video enthusiasts and 
professionals, enhances your creative power and freedom. Adobe Premiere 
Pro is the most scalable, efficient, and precise video-editing tool available. It 
supports a broad range of video formats including AVCHD, HDV, XDCAM, P2 
DVCPRO HD, XDCAM, AVC-Intra, Canon XF, RED, ARRIRAW, QuickTime, 
and many more. The superior performance of Adobe Premiere Pro lets you 
work faster and more creatively. The complete set of powerful and exclusive 
tools lets you overcome any editorial, production, and workflow challenges to 
deliver the high-quality work you demand.

About Classroom in a Book
Adobe Premiere Pro CC Classroom in a Book® is part of the official training 
series for Adobe graphics and publishing software. The lessons are designed so 
that you can learn at your own pace. If you’re new to Adobe Premiere Pro, you’ll 
learn the fundamental concepts and features you’ll need to use the program. 
This book also teaches many advanced features, including tips and techniques 
for using the latest version of this software.

The lessons in this edition include opportunities to use features such as multi-
camera editing, keying, dynamic trimming, color correction, tapeless media, 
and audio and video effects. You’ll also learn how to create files for the Internet 
and mobile devices with Adobe Media Encoder. Adobe Premiere Pro CC is 
available for both Windows and Mac OS.

Prerequisites
Before beginning to use Adobe Premiere Pro CC Classroom in a Book®, make 
sure your system is set up correctly and that you’ve installed the required 
software and hardware. You can view updated system requirements by visiting 
http://www.adobe.com/products/premiere/tech-specs.html.

You should have a working knowledge of your computer and operating system. 
You should know how to use the mouse and standard menus and commands 

Getting Started
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and also how to open, save, and close files. If you need to review these techniques, 
see the printed or online documentation included with your Windows or  
Mac OS system.

Installing Adobe Premiere Pro CC
You must purchase an Adobe Creative Cloud subscription separately from this book. 
For complete system requirements and complete instructions on installing the 
software, visit www.adobe.com/support. You can purchase Adobe Creative Cloud 
by visiting www.adobe.com/products/creativecloud. Follow the onscreen instruc-
tions. You may also want to install Photoshop, After Effects, Audition, Prelude, 
Speedgrade, Encore, and Adobe Media Encoder which are included with Adobe 
Creative Cloud for some of the extra exercises in the book.

Optimizing performance
Editing video is memory- and processor-intensive work for a computer. A fast 
processor and a lot of memory will make your editing experience much faster and 
more efficient; 4 GB of memory is the minimum, and 8 GB or more is better for 
high-definition (HD) media. Adobe Premiere Pro CC takes advantage of multicore 
processors on Windows and Macintosh systems.

A dedicated 7200 RPM or faster hard drive is recommended for high-definition 
video (HD) media. A RAID 0 striped disk array or SCSI disk subsystem is strongly 
recommended for HD. Performance will be significantly affected if you attempt to 
store media files and program files on the same hard drive. Be sure to keep your 
media files on a second disk if at all possible.

The Mercury Playback Engine in Adobe Premiere Pro can operate in software- 
only mode or GPU acceleration mode. The GPU acceleration mode provides  
significant performance improvement. The GPU acceleration is possible with  
select video cards. You can find a list of these video cards on the Adobe website  
at http://www.adobe.com/products/premiere/tech-specs.html.

Copying the lesson files
The lessons in Adobe Premiere Pro CC Classroom in a Book® use specific source files, 
such as video clips, audio files, and image files created in Adobe Photoshop CC and 
Adobe Illustrator CC. To complete the lessons in this book, you must copy all the 
files from the Adobe Premiere Pro CC Classroom in a Book® DVD (inside the back 
cover of this book or available from the link that appears on the last pages of the ebook) 

http://www.adobe.com/support
http://www.adobe.com/products/creativecloud
http://www.adobe.com/products/premiere/tech-specs.html
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to your hard drive. You will need about 8 GB of storage space in addition to the  
4 GB you need to install Adobe Premiere Pro CC.

Although each lesson stands alone, some lessons use files from other lessons, so 
you’ll need to keep the entire collection of lesson assets on your hard drive as you 
work through the book. 

Here’s how to copy those assets from the DVD to your hard drive:

1	 Open the Adobe Premiere Pro CC Classroom in a Book® DVD in My Computer 
or Windows Explorer (Windows) or in Finder (Mac OS).

2	 Right-click the folder called Lessons, and choose Copy.

3	 Navigate to the location you set to store your Adobe Premiere Pro CC projects.

The default location is your computer’s Desktop.

4	 Right-click and choose Paste.

Following these steps will copy all the lesson assets to your local folder. This process 
may take a few minutes to complete, depending on the speed of your hardware.

If you are accessing the files from the ebook version of this book, follow the direc-
tions in the last pages of the ebook.

Relinking the lesson files
It is possible that the file path to the lesson files may need to be updated. If you 
open an Adobe Premiere Pro project and it cannot find a media file, the Link Media 
dialog may open and ask you to relink offline files. If this happens, you will need to 
navigate to one of the offline files in order to reconnect. Once you’ve reconnected 
one file in the project, the rest should reconnect.

Click the Locate button and use the browser to locate an offline clip. You can navi-
gate to the same location where you copied the files you copied from the DVD. The 
path should be Desktop > Lessons > Assets. You may need to look in some of the 
included folders to find the media file (especially if it involves tapeless media). You 
can also navigate to the Lessons folder and click the Search button to have Adobe 
Premiere Pro search for the file.

When you locate a file, just select it and click the OK button.

How to use these lessons
Each lesson in this book provides step-by-step instructions for creating one or more 
specific elements of a real-world project. The lessons stand alone, but most of them 
build on previous lessons in terms of concepts and skills. So, the best way to learn 
from this book is to proceed through the lessons in sequential order.
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The organization of the lessons is workflow-oriented rather than feature-oriented, 
and the book uses a real-world approach. The lessons follow the typical sequential 
steps video editors use to complete a project, starting with acquiring video, laying 
down a cuts-only sequence, adding effects, sweetening the audio track, and ultimately 
exporting the project.

How to access updates to this book 
Purchasing this book gives you access to electronic book updates as they are made 
available covering new features that Adobe releases for Creative Cloud customers. 
For access, follow these steps:

1	 On a Mac or PC, go to www.peachpit.com/redeem.

2	 Enter the code C4C1E8543CAA.

3	 If you do not have a Peachpit.com account, you will be prompted to create one.

4	 The downloadable files will be listed under Lesson & Update Files tab on your 
Account page.

5	 Click the file links to download them to your computer. 

Additional resources
Adobe Premiere Pro CC Classroom in a Book® is not meant to replace documenta-
tion that comes with the program or to be a comprehensive reference for every  
feature. Only the commands and options used in the lessons are explained in this 
book. For comprehensive information about program features and tutorials, refer  
to these resources:

Adobe Premiere Pro Help and Support: www.adobe.com/support is where you 
can find and browse Help and Support content on Adobe.com.

Adobe Creative Cloud Learning: For inspiration, key techniques, cross-product 
workflows, and updates on new features, go to the Creative Cloud Learn page 
at https://helpx.adobe.com/creative-cloud/tutorials.html. Available only to paid 
Creative Cloud subscribers.

Adobe Forums: http://forums.adobe.com lets you tap into peer-to-peer discussions 
and questions and answers on Adobe products.

Adobe TV: http://tv.adobe.com is an online video resource for expert instruction 
and inspiration about Adobe products, including a How To channel to get you 
started with your product.

http://www.peachpit.com/redeem
http://www.adobe.com/support
https://helpx.adobe.com/creative-cloud/tutorials.html
http://forums.adobe.com
http://tv.adobe.com
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Resources for educators: www.adobe.com/education and http://edex.adobe.com 
offer a treasure trove of information for instructors who teach classes on Adobe 
software. Find solutions for education at all levels, including free curricula that use 
an integrated approach to teaching Adobe software and can be used to prepare for 
the Adobe Certified Associate exams.

Also check out these useful links:

Adobe Marketplace & Exchange: www.adobe.com/cfusion/exchange is a central 
resource for finding tools, services, extensions, code samples, and more to supplement 
and extend your Adobe products.

Adobe Premiere Pro CC product home page: www.adobe.com/products/premiere 
has more information about the product.

Adobe Labs: http://labs.adobe.com gives you access to early builds of cutting- 
edge technology, as well as forums where you can interact with both the Adobe 
development teams building that technology and other like-minded members of  
the community.

Adobe certification
The Adobe training and certification programs are designed to help Adobe  
customers improve and promote their product-proficiency skills. There are four 
levels of certification:

•	 Adobe Certified Associate (ACA)

•	 Adobe Certified Expert (ACE)

•	 Adobe Certified Instructor (ACI)

•	 Adobe Authorized Training Center (AATC)

The Adobe Certified Associate (ACA) credential certifies that individuals have the 
entry-level skills to plan, design, build, and maintain effective communications 
using different forms of digital media.

The Adobe Certified Expert program is a way for expert users to upgrade their  
credentials. You can use Adobe certification as a catalyst for getting a raise, finding  
a job, or promoting your expertise.

If you are an ACE-level instructor, the Adobe Certified Instructor program takes 
your skills to the next level and gives you access to a wide range of Adobe resources.

Adobe Authorized Training Centers offer instructor-led courses and training on 
Adobe products, employing only Adobe Certified Instructors. A directory of  
AATCs is available at http://partners.adobe.com.

For information on the Adobe Certified programs, visit www.adobe.com/support/
certification/main.html.

http://www.adobe.com/education
http://edex.adobe.com
http://www.adobe.com/cfusion/exchange
http://www.adobe.com/products/premiere
http://labs.adobe.com
http://www.adobe.com/support/certification/main.html
http://www.adobe.com/support/certification/main.html
http://partners.adobe.com
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Organizing Media

Lesson overview
In this lesson, you’ll learn about the following:

•	 Using the Project panel

•	 Staying organized with bins

•	 Adding metadata to your clips

•	 Using essential playback controls

•	 Interpreting footage

•	 Making changes to your clips

This lesson will take approximately 50 minutes.

4
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Once you have some video and sound assets in your 
project, you’ll want to get on with looking through 
your footage and adding clips to a sequence. Before 
you do, it’s well worth spending a little time organiz-
ing the assets you have. Doing so can save you hours 
of hunting for things later.
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Getting started
When you have lots of clips in your project, imported from several different media 
types, it can be a challenge to stay on top of everything and always find that magic 
shot when you need it.

In this lesson, you’ll learn how to organize your clips using the Project panel, which 
is the heart of your project. You’ll create special folders, called bins, to divide your 
clips into categories. You’ll also learn about adding important metadata and labels to 
your clips.

You’ll begin by getting to know the Project panel and organizing your clips.

Before you begin, make sure you’re using the default Editing workspace.

1	 Click Window > Workspace > Editing.

2	 Click Window > Workspace > Reset Current Workspace.

3	 Click Yes in the Reset Workspace dialog.

For this lesson, you’ll use the project file you used in Lesson 3.

4	 Continue to work with the project file from the previous lesson, or open it from 
your hard drive. If you do not have the previous lesson file, you can open the file 
Lesson 04.prproj from the Lesson 04 folder.

5	 Choose File > Save As.

6	 Rename the file Lesson 04.prproj.

7	 Choose a preferred location on your hard drive, and click Save to save the project.

The Project panel
Anything you import into your Adobe Premiere Pro CC project will appear in the 
Project panel. As well as giving you excellent tools for browsing your clips and 
working with their metadata, the Project panel has special folders, called bins, that 
you can use to organize everything.

No matter how you import your clips, everything that appears in a sequence must 
appear in the Project panel. If you delete a clip in the Project panel that is already 
used in a sequence, the clip will automatically be removed from the sequence. Don’t 
worry, though, because Adobe Premiere Pro will warn you if you do this.
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As well as acting as the repository for all of your clips, the Project panel gives you 
important options for interpreting media. All of your footage will have a frame rate 
and pixel aspect ratio, for example, and you may want to change these settings for 
creative reasons. You could, for example, interpret 60fps video as 30fps to achieve 
a slow-motion effect. You might also receive a video file that has the wrong pixel 
aspect ratio setting.

Adobe Premiere Pro uses metadata associated with footage to know how to play it 
back. If you want to change the clip metadata, you can do so in the Project panel.

Customizing the Project panel
It’s quite likely that you will want to resize the Project panel from time to time. 
You’ll be alternating between looking at your clips as a list or as thumbnails, and 
sometimes it’s quicker to resize the panel than scroll over to see more information.

The default Editing workspace is designed to keep the interface as clean as possible 
so you can focus on your creative work rather than the buttons. Part of the Project 
panel that’s hidden from view, called the Preview Area, gives additional information 
about your clips.

E Tip:  There’s a very 
quick way to toggle 
between seeing the 
Project panel in a frame 
and seeing it full-screen. 
Just hover your mouse 
cursor over the panel 
and press the ` (grave) 
key. You can do this 
with any panel in  
Adobe Premiere Pro.

Filter bin content

Sequence

Headings

Clip

List view

Icon view Zoom Sort icons Find New bin
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Let’s take a look at it:

1	 Click the panel menu for the Project panel.

2	 Choose Preview Area.

The Preview Area shows you several kinds of useful information about a clip 
when you select it in the Project panel, including the frame size, pixel aspect 
ratio, and duration.

If it is not already selected, click the List View button  at the bottom-left 
corner of the Project panel. In this view, a lot of information is available about 
each clip in the Project panel, but you need to scroll horizontally to see it.

The Preview Area gives you a mix of information about clips when you need it.

3	 Click the panel menu for the Project panel.

4	 Choose Preview Area to hide it.

P	Note:  Be sure to 
follow the instructions 
in the “Getting started” 
section that begins this 
lesson.

Poster frame Clip nameClip type Frame size

Play/Stop Audio type Duration and frame rate
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Finding assets in the Project panel
Working with clips is a little like working with pieces of paper at your desk. If you 
have just one or two clips, it’s easy. Once you have one or two hundred, you need  
a system!

One way you can help make things smoother during the edit is to take a little time 
to organize your clips at the very beginning. If you can name your clips during 
capture or after importing them, it can help enormously. Even if you don’t give each 
individual clip its own name during capture from tape, you can give a name to each 
type of shot and let Adobe Premiere Pro add 01, 02, 03, and so on (see Lesson 3, 
“Importing Media”).

1	 Click the Name heading at the top of the Project panel. The items in the Project 
panel are displayed in alphabetical order or reverse alphabetical order when you 
click the Name heading again.

2	 Scroll to the right until you can see the Media Duration heading in the Project 
panel. This shows the total duration of each clip’s media file.

P Note:  When you scroll to the right in the Project panel, Adobe Premiere Pro always  
maintains the clip names on the left so you know which clips you’re seeing information about.

3	 Click the Media Duration heading. Adobe Premiere Pro displays the clips in 
order of media duration. Notice the direction arrow on the Media Duration 
heading. When you click the heading, the direction arrow toggles between 
showing clips in duration order or reverse duration order.

If you’re looking for lots of clips with particular features—such as a duration  
or a frame size—it can be helpful to change the order in which the headings  
are displayed.

4	 Drag the Media Duration heading to the left until you see a blue divider  
between the Label heading and the Name heading. When you release the  
mouse button, the Media Duration heading will be repositioned right next to  
the Name heading.

The blue divider shows where you will drop the heading.

E Tip:  You can scroll 
the Project panel view 
up and down using the 
scroll wheel on your 
mouse.

P	Note:  Graphic 
and photo files like 
Photoshop PSD, 
JPEG, or Illustrator AI 
files import with the 
duration you set in 
Preferences > General > 
Still Image Default 
Duration.

P	Note:  You may need 
to drag to expand the 
width of a column to 
see its arrow.
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Filter bin content

Adobe Premiere Pro has built-in search tools to 
help you find your media. Even if you are using 
the rather non-descriptive original clip names 
taken from a file-based camera, you can search 
for things like a frame size or a file type.

At the top of the Project panel, you can type in the Filter Bin Content box to display 
only clips that match the text you enter. This is a very quick and easy way of locating 
a clip if you remember what it is called. Clips that don’t match the text you enter are 
hidden and clips that do are revealed, even if they are inside a bin.

1	 Click in the Filter Bin Content box, and type the letters joh.

Adobe Premiere Pro displays only the clips with the letters “joh” in the name or 
in the metadata. Notice that the name of the project is displayed above the text 
entry box, along with “(filtered).”

2	 Click the X on the right of the Filter Bin Content box to clear your filter.

3	 Type the letters psd in the box.

Adobe Premiere Pro displays only clips that have the letters “psd” in their name or 
metadata, along with all the project bins. In this case, it’s the Theft Unexpected title 
you imported earlier as both a flattened and a layered image. Using the Filter Bin 
Content box in this way, you can look for particular types of files.

To the left of the text entry box, there’s a but-
ton menu that displays a list of recent entries, 
along with the number of clips that match the 
search criteria.

To the right of the Filter Bin Content box, 
there’s an In menu where you can specify whether Adobe Premiere Pro should 
search for clips based on all of the available metadata, just the metadata displayed 
currently (see “Working with bins” later in this lesson), or words taken from scripts 
(see “Organizing media with content analysis” later in this lesson).

Usually, it isn’t necessary to choose anything in this menu, because the filtering 
works when using the All option if you type selections carefully. Be sure to click 
the X on the right of the Filter Bin Content box to clear your filter.

P	Note:  The folders you create inside the Project panel are called bins. This is a term taken from 
film editing. The Project panel itself is effectively a bin, since you can contain clips inside it. It 
functions exactly like any other bin and is referred to as one.
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Find

Adobe Premiere Pro also has an advanced Find option. To learn about it, let’s 
import a couple of extra clips.

1	 Using any of the methods described in Lesson 3, import these items:

•	 Seattle_Skyline.mov from the Assets/Video and Audio Files/General  
Views folder.

•	 Under Basket.MOV from the Assets/Video and Audio Files/Basketball folder.

2	 At the bottom of the Project panel, click the Find button  . Adobe Premiere 
Pro displays the Find panel, which has more advanced options for locating 
your clips.

There are two sets of searches you can perform at the same time with the Adobe 
Premiere Pro Find panel. You can choose to display clips that match both search 
criteria or either search criterion. For example, you could do either of the following:

•	 Search for a clip with the words dog AND boat in its name.

•	 Search for a clip with the word dog OR boat in its name.

Then choose from the following options:

•	 Column: Selects from the available headings in the Project panel. When you 
click Find, Adobe Premiere Pro will search using only the heading you select.

•	 Operator: Gives you a set of standard search options. Use this menu to choose 
whether you want to find a clip that contains, matches exactly, begins with, or 
ends with whatever you search for.

•	 Match: Choose All to find a clip with both your first and second search text. 
Choose Any to find a clip with either your first or your second search text.

•	 Case Sensitive: Tells Adobe Premiere Pro whether you want your search to 
exactly match the upper- and lowercase letters you enter.

•	 Find What: Type your search text here. You can add up to two sets of search text.

When you click Find, Adobe Premiere Pro highlights a clip that matches your search 
criteria. Click Find again, and Adobe Premiere Pro highlights the next clip that 
matches your search criteria. Click Done to exit the Find dialog box.
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Working with bins
Bins have the same icon as a folder on your hard 
drive and work in almost exactly the same way. 
They allow you to store your clips in a more orga-
nized way, by dividing them into different groups.

Just like folders on your hard drive, you can have 
multiple bins inside other bins, creating a folder 
structure as comprehensive as your project requires.

There’s one very important difference between 
bins and folders on your hard drive: Bins exist only inside your Adobe Premiere Pro 
project file. You won’t see individual project bins anywhere on your hard drive.

Creating bins
Let’s create a bin.

1	 Click the New Bin button  at the bottom of the Project panel.

Adobe Premiere Pro creates a new bin and automatically highlights the name, 
ready for you to rename it. It’s a good idea to get into the habit of naming bins 
when you create them.

2	 We have some clips from a film, so let’s give them a bin. Name the bin  
Theft Unexpected.

3	 You can also create a bin using the File menu. Choose File > New > Bin.

4	 Name this bin PSD Files.

5	 You can also make a new bin by right-clicking a blank area in the Project panel 
and choosing New Bin. Try this now.

6	 Name the new bin Illustrator Files.

One of the quickest and easiest ways to create a new bin for clips you already 
have in your project is to drag and drop the clips onto the New Bin button at the 
bottom of the Project panel.

7	 Drag and drop the clip Seattle_Skyline.mov onto the 
New Bin button.

8	 Name the newly created bin City Views.

9	 Press the keyboard shortcut Control+/ (Windows) 
or Command+/ (Mac OS) to make a new bin.

10	Name the bin Sequences.

If your Project panel is set to List view, bins are 
displayed in name order among the clips.

P	Note:  It can be quite 
difficult to find a blank 
part of the Project panel 
to click when it is full of 
clips. Try clicking just 
to the left of the icons, 
inside the panel.

P	Note:  When you 
import an Adobe 
Photoshop file with 
multiple layers and 
choose to import 
as a sequence, 
Adobe Premiere Pro 
automatically creates 
a bin for the individual 
layers and their 
sequence.
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Managing media in bins
Now that we have some bins, let’s put them to use. As you move clips into bins, use 
the disclosure triangles to hide their contents and tidy up the view.

1	 Drag the clip Brightlove_film_logo.ai into the Illustrator Files bin.

2	 Drag Theft_Unexpected.psd into the PSD Files bin.

3	 Drag the Theft_Unexpected_Layered bin (created automatically when you 
imported the layered PSD file) into the PSD Files bin. Bins inside bins work just 
like folders inside folders.

4	 Drag the clip Under Basket.MOV into the City Views bin. You might need to 
resize the panel or switch it to full-screen to see both the clip and the bin.

5	 Drag the sequence First Sequence into the Sequences bin.

6	 Put all of the remaining clips inside the Theft Unexpected bin.

You should now have a nicely organized Project panel, 
with each kind of clip in its own bin.

Notice that you can also copy and paste clips to make 
extra copies if this suits your organizational system. You 
have a Photoshop document that might be useful for the 
Theft Unexpected content. Let’s make an extra copy.

7	 Click the disclosure triangle for the PSD Files bin to display the contents.

8	 Right-click the Theft_Unexpected.psd clip, and choose Copy.

9	 Click the disclosure triangle for the Theft Unexpected bin to display the contents.

10	Right-click the Theft Unexpected bin, and choose Paste.

Adobe Premiere Pro places a copy of the clip in the Theft Unexpected bin.

Finding your media
If you’re not sure where your media is on your hard drive, right-click the clip in the 
Project panel and choose Reveal in Explorer (Windows) or Reveal in Finder (Mac OS).

Adobe Premiere Pro will open the folder on your hard drive that contains the media 
file and highlight it. This can be very useful if you are working with media files stored 
on multiple hard drives or if you have renamed your clips in Adobe Premiere Pro.

E Tip:  You can make 
Shift-click and Control-
click (Windows) or 
Command-click (Mac 
OS) selections in the 
Project panel, just as 
you can with files in 
your hard drive.

P	Note:  When you 
make copies of clips, 
you are not making 
copies of the media 
files they are linked to. 
You can make as many 
copies as you like of a 
clip inside your Adobe 
Premiere Pro project. 
Those copies will all link 
to the same original 
media file.
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Changing bin views
Though there is a distinction between the Project panel and bins, they have the 
same controls and viewing options. For all intents and purposes, you can treat the 
Project panel as a bin.

Bins have two views. You choose between them by clicking the List View or Icon 
View button at the bottom left of the Project panel.

•	 List view: Displays your clips and bins as a list, with a significant amount of 
metadata displayed. You can scroll through the metadata, and use it to sort clips 
by clicking on column headers.

•	 Icon view: Displays your clips and bins as thumbnails you can rearrange and 
play back.

The Project panel has a Zoom control, which changes the size of the clip icons or 
thumbnails.

1	 Double-click the Theft Unexpected bin to open it in its own panel.

2	 Click the Icon View button on the Theft Unexpected bin to display thumbnails 
for the clips.

3	 Try adjusting the Zoom control.

Adobe Premiere Pro can display very large thumbnails to make browsing and 
selecting your clips easy.

You can also apply various kinds of sorting to clip thumbnails in Icon view by 
clicking the Sort Icons  menu.

4	 Switch the view to List view.

5	 Try adjusting the Zoom control for the bin.

When you’re in List view, it doesn’t make that much sense to zoom, unless you 
turn on the display of thumbnails in this view.

6	 Click the panel menu, and choose Thumbnails.

Adobe Premiere Pro now displays thumbnails in List view, as well as in Icon view.
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7	 Try adjusting the Zoom control.

The clip thumbnails show the first frame of the media. In some cases, this is not 
particularly useful. Look at the clip HS Suit, for example. The thumbnail shows a 
clapper board, but it would be useful to see the character.

8	 Click the panel menu, and choose Preview Area.

9	 Select the clip HS Suit so that information about it is displayed in the 
Preview Area.

10	The Thumbnail Viewer in the Preview Area allows you to play your clip, 
drag through it, and set a new poster frame. Drag through the clip using the 
Thumbnail Viewer until you see the character.

11	Click the Poster Frame button on the Thumbnail Viewer.

Adobe Premiere Pro shows your newly selected frame as the thumbnail for  
this clip.

12	Use the panel menu to turn off thumbnails in List view and to hide the 
Preview Area.
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Assigning labels
Every item in the Project panel has a label color. In List view, the Label heading 
shows the label color for every clip. When you add your clips to a sequence, they 
will appear in the Timeline panel with this color.

Let’s change the color for the title so that it matches the other clips in this bin.

1	 Right-click Theft_Unexpected.psd and choose Label > Iris.

2	 Make sure the floating Theft Unexpected bin is active by clicking once 
somewhere inside the panel.

3	 Press Control+A (Windows) or Command+A (Mac OS) to select every clip in 
the bin.

4	 You can change label colors for multiple clips in a single step. Right-click any of 
the clips in the bin, and choose Label > Forest.

5	 Change the Theft Unexpected video clips back to Iris, and the Theft_
Unexpected.psd clip back to Lavender (be sure to change both copies). If you 
have these clips visible in two bin panels, you’ll see them update in both views.

Changing the available label colors
Eight available colors can be assigned as labels to items in your project. There are 
also eight types of items that label colors can be assigned to, and this means there 
aren’t any spare label colors.

If you choose Edit > Preferences > Label Colors (Windows) or Premiere Pro > 
Preferences > Label Colors (Mac OS), you can see the list of colors, each with a color 
swatch you can click to change the color to something else.

If you select Label Defaults in the preferences, you can choose different default 
labels for each kind of item in your project.

P	Note:  You can 
change the label color 
for multiple clips by 
choosing them first.
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Changing names

Because clips in your project are separate from the media files they link to, you can 
rename items inside Adobe Premiere Pro, and the names of your original media files 
on the hard drive are left untouched. This makes renaming clips safe to do!

1	 Right-click either instance of the clip Theft_Unexpected.psd, and choose Rename.

2	 Change the name to TU Title BW.

3	 Right-click the newly renamed clip, TU Title BW, and choose Reveal in Explorer 
(Windows) or Reveal in Finder (Mac OS).

Notice that the original filename has not changed. It’s helpful to be clear about 
the relationship between your original media files and the clips inside Adobe 
Premiere Pro, because it explains much of the way Adobe Premiere Pro works.

Customizing bins
Adobe Premiere Pro displays certain types of information in the Project panel by 
default. You can easily add or remove headings. Depending on the clips you have 
and the types of metadata you are working with, you might want to display or hide 
different kinds of information.

1	 If it’s not open already, open the Theft Unexpected bin.

2	 Click the panel menu, and choose Metadata Display.

The Metadata Display panel allows you to choose any kind of metadata to use as 
a heading in the List view of the Project panel (and any bins). All you have to do 
is select the check box for the kind of information you would like to be included.

P	Note:  When you 
change the name of a 
clip in Adobe Premiere 
Pro, the new name is 
stored in the project file. 
Two project files could 
easily have different 
names representing  
the same clip.



78  Lesson 4 O rganizing Media

3	 Click the disclosure triangle for Premiere Pro Project Metadata to show  
those options.

4	 Select the Media Type check box.

5	 Click OK.

You’ll notice that Media Type is now added as a heading for the Theft Unexpected 
bin but not for any other bins. To make this kind of change to every bin in one step, 
use the panel menu on the Project panel, rather than on an individual bin.

Some of the headings are for information only, while others can be edited directly. 
The Scene heading, for example, allows you to add a scene number for each clip.

Notice that if you enter a number for a scene and 
then press the Enter key, Adobe Premiere Pro  
activates the next scene box. This way, you can use 
the keyboard to quickly enter information about 
each clip, jumping from one box to the next.

The Scene heading is a special one. It gives you  
information about what the scene clips are intended for; it also gives Adobe Premiere 
Pro information about which scene from an original script should be used for auto-
matic analysis of the audio (see “Organizing media with content analysis” later in 
this lesson).

Adobe Story
Adobe Story is a script-writing application that automates the process of cor-
rectly formatting scripts and integrates into your editing workflow with Adobe 
Premiere Pro.

As well as giving you tools for script writing, Adobe Story supports collaboration 
with other writers, automatic versioning, and tagging scripts with metadata for 
preproduction planning, and it can generate script reports and schedules to help 
you prepare for production.
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Having multiple bins open at once
When you double-click a bin, by default Adobe Premiere Pro opens the bin in a 
floating panel. Every bin panel behaves in the same way, with the same options, but-
tons, and settings.

If you have room on your computer monitor, you can have as many bins open as  
you like.

Bins are like any other kind of panel in that you can drag them to any part of the 
interface, resize them, combine them with other panels, and toggle them between 
full-screen and frame display using the ` (grave) key.

Bins open in their own panel when you double-click them because of the default 
preferences, which you can change to suit your editing style.

Choose Edit > Preferences > General (Windows) or Premiere Pro > Preferences > 
General (Mac OS) to change the options.

Each of the options lets you choose what will happen when you double-click, 
double-click with the Control (Windows) or Command (Mac OS) key, or double-
click with the Alt (Windows) or Option (Mac OS) key.

Organizing media with content analysis
Increasingly, metadata is used to help you stay organized and share information 
about your clips. The challenge with metadata is in finding efficient ways to create it 
and add it to your clips.

To make this process much easier, Adobe Premiere Pro can analyze your media and 
automatically create metadata based on the content. The words that are spoken can 
be added as time-based text, and clips with faces can be marked as such to make it 
easier to identify useful shots.
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Using the Adobe Story panel
The Speech to Text function listens to the words spoken in your footage and creates 
text associated with your clips. The text is linked in time to when the words are 
spoken, so you can easily locate the part of a clip you want.

The accuracy of the analysis depends on several factors. You can help Adobe 
Premiere Pro correctly identify the words that are spoken by associating a script or 
transcript with your clips.

The Adobe Story panel gives you access to your Adobe Story scripts, and allows 
you to drag and drop scenes onto clips. These are used to improve the accuracy of 
speech analysis.

Access the Adobe Story panel in the Window menu, log in, and you’ll have access to 
your existing scripts.

Dragging scenes from the Adobe Story panel is one method of associating text with 
clips. Another method is to browse for a text file on your local storage drive.

Speech analysis
To initiate the Speech to Text function, do the following:

1	 Import the video file Mid John - 00028.mp4 from the Lesson 04 folder.

2	 Scroll along in the Project panel until you can see the Scene heading.  
If necessary, add the scene number 1 for the new Mid John clip.

3	 Double-click the new Mid John clip. If the Theft Unexpected bin obscures the 
Source Monitor, you can close the bin by clicking on the X on the bin’s panel tab.

Adobe Premiere Pro displays the clip in the Source Monitor.

4	 Click the tab for the Metadata panel to display it. In the default Editing 
workspace, you’ll find that the Metadata panel shares a frame with the Source 
Monitor. If it isn’t there, click the Window menu and choose Metadata.

P	Note:  There’s a zip 
file in that folder with 
an original copy of the 
video clip, so you can 
try this again if you’d 
like. Once you use the 
Adobe Premiere Pro 
Speech to Text feature, 
the original file has the 
additional metadata 
added, which will be 
available whenever you 
import it.
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The Metadata panel shows you many different kinds of metadata about clips in  
your project. To view the Metadata panel at the same time as the Source Monitor, 
drag it onto the Program Monitor using the tab. Then click the Source Monitor tab 
to bring it into view.

5	 Click the Analyze button at the bottom right of the Metadata panel.

The Analyze Content panel gives you options for how the automatic analysis will 
take place. You simply need to decide whether you want Adobe Premiere Pro 
to detect faces, identify speech, or both, and then choose the language and the 
quality settings.

To improve the speech detection accuracy, we’re going to attach a script file.

6	 Click the Reference Script menu, and choose Add.

7	 Browse to the Lesson 04 folder, and open Theft Unexpected.astx. Adobe Premiere 
Pro displays the Import Script dialog so you can confirm you have chosen the 
right script. Check the box to confirm that the script text exactly matches the 
recorded dialogue. This forces Adobe Premiere Pro to use only the words in the 
original script (useful for interview transcriptions). Click OK.

8	 Select Identify Speakers in the Analyze Content panel.

This tells Adobe Premiere Pro to separate dialogue from different voices.

P	Note:  You may need 
to resize the panel to 
see the button.
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9	 Leave all of the other settings at their defaults, and click OK.

Adobe Premiere Pro starts the Adobe Media Encoder, which conducts the 
analysis in the background. This allows you to carry on working in your project 
while the analysis happens. When the analysis is complete, a text description of 
the words spoken is displayed for the clip in the Metadata panel.

Adobe Media Encoder starts the analysis automatically and plays a completion 
sound when it has finished. You can set off multiple clips for analysis, and  
Adobe Media Encoder will automatically add them to a queue. You can quit Adobe 
Media Encoder when it has completed its tasks.

Face detection
With so many clips in larger projects, anything that makes it easier to find the right 
shot helps. Turning on face detection when analyzing your clips provides an extra 
way of searching for content.

Now that you have analyzed the Mid John clip, try clicking the Recent Searches  
button for the Filter Bin Content box in the Project panel and choosing Find Faces. 
The Mid John clip will be displayed, even if you put it into a bin. Be sure to click the 
X on the right of the Filter Bin Content box to clear your filter.

Monitoring footage
The greater part of video editing is invested in watching clips and making creative 
choices about them. It’s important to feel really comfortable browsing media.

Adobe Premiere Pro has multiple ways of performing common tasks such as play-
ing video clips. You can use the keyboard, click buttons with your mouse, or use an 
external device like a jog/shuttle control.

You can also use a feature called hover scrub to quickly and easily view the contents 
of your clips right in the bin.

1	 Double-click the Theft Unexpected bin to open it.

2	 Click the Icon View button at the bottom-left corner of the bin.

3	 Drag your mouse, without clicking, across any of the images in the bin.

Adobe Premiere Pro displays the contents of the clip as you drag. The left edge of 
the thumbnail represents the beginning of the clip, and the right edge represents 
the end. In this way, the width of the thumbnail represents the whole clip.

E Tip:  Adding a scene 
number for your clips 
helps Adobe Premiere 
Pro identify the part 
of the script that the 
dialogue relates to.
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4	 Select a clip by clicking it once. Hover scrubbing is now turned off, and a mini 
scrollbar appears at the bottom of the thumbnail. Try dragging through the clip 
using the scrollbar.

Adobe Premiere Pro uses the J, K, and L keys on your keyboard to perform 
playback too, just like the Media Browser.

•	 J: Play backward

•	 K: Pause

•	 L: Play forward

5	 Select a clip, and use the J, K, and L keys to play the thumbnail. Be sure to click 
the clip only once. If you double-click, it will open in the Source Monitor.

When you double-click a clip, not only 
is it displayed in the Source Monitor, but 
it’s also added to a list of recent clips.

E Tip:  If you press 
the J or L key multiple 
times, Adobe Premiere 
Pro will play the video 
clips at multiple speeds.
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6	 Double-click to open four or five clips from the Theft Unexpected bin.

7	 Click the Recent Items menu, on the tab at the top of the Source Monitor, to 
browse between your recent clips.

8	 Click the Zoom menu at the bottom of the Source Monitor. 
By default, this is set to Fit, which means Adobe Premiere 
Pro will display the whole frame, regardless of the original 
size. Change the setting to 100%.

These Theft Unexpected clips are high-resolution, and they are probably much 
bigger than your Source Monitor. You are likely to have scrollbars at the bottom 
and on the right of your Source Monitor now, so you can view different parts of 
the image.

The benefit of viewing with Zoom set to 100% is that you see every pixel of the 
original video, which is useful for checking the quality.

9	 Set the Zoom menu back to Fit.

Playback resolution

If you have an older or slower processor, your computer may 
struggle to play back very high-quality video clips. To work 
with a wide variety of computer hardware configurations, from 
powerful desktop workstations to lightweight portable laptops, Adobe Premiere Pro 
can lower the playback resolution to make playback smoother. You can switch the 
playback resolution as often as you like, using the Select Playback Resolution menu 
on the Source Monitor and Program Monitor.

Timecode information

At the bottom left of the Source Monitor, a timecode display shows the current 
position of the playhead in hours, minutes, seconds, and frames (00:00:00:00). Note 
that this is based on the original timecode for the clip, which might not begin at 0.

At the bottom right of the Source Monitor, a timecode display shows the total 
selected duration for your clip. Later, you’ll be adding special marks to make a  
partial selection. For now, it shows the complete duration.

Safe margins

Old-style CRT monitors crop the edges of the picture to achieve a clean edge. If you 
are producing video for a CRT monitor, click the Settings (wrench icon) button at 
the bottom of the Source Monitor and choose Safe Margins. Adobe Premiere Pro 
displays white outlines over the image.

E Tip:  Notice that you 
have the option to close 
a single clip or close 
all clips, clearing the 
menu and the monitor. 
Some editors like to 
clear the menu and 
then open several clips 
that are part of a scene 
by selecting them all in 
the bin and dragging 
them into the Source 
Monitor together. They 
can then use the Recent 
Items menu to browse 
only the clips from this 
short list.
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The outer box is the action-safe zone. Aim to keep important action inside this box 
so that when the picture is displayed, cropping does not hide what is going on.

The inner box is the title-safe zone. Keep titles and graphics inside this box so that 
even on a badly calibrated display, your audience will be able to read the words.

The inner vertical lines show the action-safe and title-safe zones when a 16:9 image 
is cropped on a 4:3 display. 

Click the Settings button at the bottom of the Source Monitor and choose Safe 
Margins to turn them off.

Essential playback controls
Let’s look at the playback controls.

1	 Double-click the shot Excuse Me in the Theft Unexpected bin to open it in the 
Source Monitor.

Playhead Time ruler

Navigator Step Back Play Step Forward
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2	 At the bottom of the Source Monitor, there’s a yellow playhead marker. Drag 
it along the bottom of the panel to view different parts of the clip. You can 
also click wherever you want the playhead to go, and it will jump to wherever 
you click.

3	 Below the clip navigation bar and the playhead, there is a scrollbar that 
doubles as a Zoom control. Drag one end of the scrollbar to zoom in on the 
clip navigator.

4	 Click the Play button to play the clip. Click it again to stop playback. You can also 
use the spacebar to play and stop playback.

5	 Click the Step Back and Step Forward buttons to move through the clip one 
frame at a time. You can also use the Left Arrow and Right Arrow keys on your 
keyboard.

6	 Use the J, K, and L keys to play your clip.

Customizing the monitors
To customize your monitors, click the Settings button  on the Source Monitor.

This menu gives you several different display options for your Source Monitor (the 
Program Monitor has a similar menu). You can choose to view waveforms and vec-
tor scopes to analyze your video.

For now, we just want to know how to get regular video onscreen. Make sure 
Composite Video is selected in this menu.

You can add or remove buttons at the bottom of the Source Monitor.

1	 Click the Button Editor button at the bottom right of the Source Monitor.

A special set of buttons appears.

2	 Drag the Loop button  from the floating panel to the right of the Play button 
on the Source Monitor, and click OK.

3	 Double-click the Excuse Me clip in the Theft Unexpected bin to open it in the 
Source Monitor if it isn't there already.

4	 Click the Loop button to enable it, and then play the video using the spacebar or  
the Play button on the Source Monitor. Stop the playback when you’ve seen enough.

With Loop turned on, Adobe Premiere Pro continuously repeats playback.

Drag here Drag here
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Modifying clips
Adobe Premiere Pro uses metadata associated with clips to know how to play them 
back. Occasionally, this metadata will be wrong, and you’ll need to tell Adobe 
Premiere Pro how to interpret a clip.

You can change the interpretation of clips for one file or multiple files in a single 
step. To do so, just select the clips you want to change.

Adjusting audio channels
Adobe Premiere Pro has advanced audio management features. You can create 
complex sound mixes and selectively target output audio channels with original 
clip audio. You can produce mono, stereo, 5.1, and even 32-channel sequences with 
precise control over which audio goes where.

If you’re just starting out, you’ll probably want to produce stereo sequences and 
might well be working with stereo source material. In this case, the default settings 
are most likely exactly what you need.

When recording audio with a professional camera, it’s common to have one micro-
phone record onto one audio channel and a different microphone record onto 
another audio channel. Though these are the same audio channels that would be 
used for regular stereo audio, they now contain completely separate sound.

Your camera adds metadata to the audio that is recorded to tell Adobe Premiere Pro 
whether the sound is meant to be mono (separate audio channels) or stereo (channel 1 
audio and channel 2 audio combine to produce the complete stereo sound).

You can tell Adobe Premiere Pro how to interpret audio channels when new media 
files are imported by going to Edit > Preferences > Audio (Windows) or Premiere 
Pro > Preferences > Audio (Mac OS).

If the setting was wrong when you imported your clips, it’s easy to tell Adobe 
Premiere Pro how to correctly interpret the audio channels.

1	 Right-click the Reveal clip in the Theft Unexpected bin, and choose Modify > 
Audio Channels.
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2	 Right now, this clip is set to use the file’s metadata to identify the channel format 
for the audio. Click the Preset menu, and change it to Mono.

Adobe Premiere Pro switches the Channel Format menu to Mono. You’ll see that 
the Left and Right source channels are now linked to tracks Audio 1 and Audio 2.  
This means that when you add the clip to a sequence, each audio channel will go 
on a separate track, allowing you to work on them independently.

3	 Click OK.

Merging clips
It’s quite common for video to be recorded on a camera with relatively low-quality 
audio, while high-quality sound is recorded on a separate device.  When working 
this way, you will want to combine the high-quality audio with the video by merging 
them.

The most important factor when merging video and audio files in this way is syn-
chronization. You will either manually define a sync point—like a clapper-board 
mark—or allow Adobe Premiere Pro to sync your clips automatically based on their 
timecode information or audio.

If you choose to sync clips using audio, Adobe Premiere Pro will analyze both the  
in-camera audio and the separately captured sound, and match them up automatically.

•	 If you have matching audio in the clips you wish to merge, you may be able to 
sync them automatically. If not, you can add a marker, add an In mark or an Out 
mark, or even use external timecode. If you’re adding a mark, place it on a clear 
sync point like a clapper board.

•	 Select the clip with audio and video, and the clip with audio-only. Right-click 
either item, and choose Merge Clips.

•	 Under Synchronize Point, choose your sync point, and click OK.

A new clip is created that combines the video and the “good” audio in a single item.
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Interpreting footage
For Adobe Premiere Pro to interpret a clip correctly, it needs to know the frame rate 
for the video, the pixel aspect ratio (the shape of the pixels), and the order to display 
the fields, if your clip has them. Adobe Premiere Pro can find out this information 
from the file’s metadata, but you can change the interpretation easily.

1	 Import RED Video.R3D from the Lesson 04 folder. Double-click it to open it in 
the Source Monitor. It’s full anamorphic widescreen, which is a little too wide for 
our project.

2	 Right-click the clip in the bin, and choose Modify > Interpret Footage.

3	 Right now, the clip is set to use the pixel aspect ratio setting from the file: 
Anamorphic 2:1. This means the pixels are twice as wide as they are tall.

4	 Use the Conform To menu to change the Pixel Aspect Ratio setting to DVCPRO 
HD (1.5). Then click OK.

From now on, Adobe Premiere Pro will interpret the clip as having pixels that are 
1.5 times wider than they are tall. This reshapes the picture to make it standard  
16:9 widescreen. This won’t always work—in fact, it often introduces unwanted  
distortion—but it can provide a quick fix for mismatched media (a common prob-
lem for news editors).

Working with raw files
Adobe Premiere Pro has special settings for R3D files created by RED cameras, and 
for ARI files created by ARRI cameras. These files are similar to the Camera Raw 
format used by professional DSLR still cameras. Raw files always have a layer of 
interpretation applied to them in order to view them. You can change the inter-
pretation at any time without impacting playback performance. This means you 
can make changes, for example, to the colors in a shot without requiring any extra 
processing power. You could achieve a similar result using a special effect, but your 
computer would have to do more work to play the clip.

1	 Right-click the RED Video.R3D clip in the Project panel, and choose  
Source Settings.



90  Lesson 4 O rganizing Media

The RED R3D Source Settings dialog appears, giving you access to the original 
interpretation controls for the clip. In many ways, this is a powerful color 
correction tool, with automatic white balance and individual adjustment of the 
red, green, and blue values.

2	 On the right, there is a series of individual controls for adjusting the picture. 
Scroll down to the very end of the list, where you’ll find Gain Settings. Since this 
is a RED clip, let’s increase the Red gain to about 1.5. You can drag the slider 
control, drag the orange number, or click and type over the number.

3	 Click OK, and take another look at the clip in the Source Monitor. You may need 
to move the playhead to see the updated result.

The picture has updated. If you had already edited this clip into a sequence,  
it would update inside the sequence, too.

For more information about working with RED media, go to  
http://www.adobe.com/go/red/.

http://www.adobe.com/go/red/
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Review questions
1	 How do you change the List view headings displayed in the Project panel?

2	 How can you quickly filter the display of clips in the Project panel to make finding 
a clip easier?

3	 How do you create a new bin?

4	 If you change the name of a clip in the Project panel, does it change the name of the 
media file it links to on your hard drive?

5	 What keys can you use to play back video and sound clips?

6	 How can you change the way clip audio channels are interpreted?

Review answers
1	 Click the panel menu for the Project panel, and choose Metadata Display. Select the 

check box for any heading you would like to appear.

2	 Click into the Filter Bin Content box, and start typing the name of the clip you are 
looking for. Adobe Premiere Pro hides any clips that don’t match and displays those 
that do.

3	 Click the New Bin button at the bottom of the Project panel. Or, go to the File menu 
and choose New > Bin. Or, right-click a blank area in the Project panel and choose 
New Bin. Or, press Ctrl+/ (Windows) or Command+/ (Mac OS). You can also drag and 
drop clips onto the New Bin button on the Project panel.

4	 No, you can duplicate, rename, or delete clips in your Project panel, and nothing will 
happen to your original media files. Adobe Premiere Pro is a nondestructive editor and 
will not modify your original files.

5	 The spacebar plays and stops. J, K, and L can be used like a shuttle controller to play 
backward and forward, and the arrow keys can be used to move one frame backward or 
one frame forward.

6	 Right-click the clip you want to change, and choose Modify > Audio Channels. Choose 
the correct option (usually by selecting a preset), and click OK.



460  Index

Numbers

3D effects
Distance to Image, 226
Specular Highlight, 226
Swivel, 226
Tilt, 226
using, 224–226

5.1 audio mix, producing with Audition, 264
8-bit video, explained, 352
32-bit color effects, using with video, 304

A

AAF (Advanced Authoring Format) files
exporting, 37–38, 452
importing, 38

A/B editing mode, function of, 156
accelerated effects, using with video, 303
Add Edit keyboard shortcuts, using, 137
additive color, explained, 339
adjustment layers, using with video effects, 

307–310
Adobe After Effects CC

animating layers, 416
animating text, 415–418
described, 12
downloading presets, 313
Roto Brush tool, 384
sending clips to, 311–313

Adobe Audition CC
described, 12
producing 5.1 mix with, 264
removing background noise, 292–294
sending audio to, 255

Adobe Dynamic Link
features, 12, 56–57
media management, 431
using to move clips, 311–313

Adobe Illustrator CC
described. 12
Edit Original option, 58
importing files, 58

Adobe Media Encoder CC. See also exports
AAC Audio, 442

Add Source option, 449
AIFF (Audio Interchange File Format), 442
Animated GIF and GIF, 444
configuring exports, 444–446
described, 12
DNxHD MXF OP1a format, 442
DPX format, 442
F4V format, 443, 447
file format for export, 442–444
FLV format, 443, 447
H.264 Blu-ray format, 443
H.264 format, 443, 447
importing sequences directly, 449
JPEG format, 443
Microsoft AVI formats, 444
modifying items, 450
modifying presets, 450
MP3 format, 443
MPEG formats, 443, 447
MXF OP1a format, 443
Output panel, 446
P2 Movie format, 443
PNG format, 443
QuickTime format, 443
rendering After Effects compositions, 449
Source panel, 446
Targa format, 443
TIFF format, 443
using formats, 447
Video tab, 448
Watch Folders, 450
Waveform Audio format, 443
Windows Bitmap format, 444
Windows Media format, 444, 447

Adobe Photoshop CC
creating graphics, 406–407
creating titles, 406–407
described, 12
image tips, 58
importing flattened files, 56–57
importing layered files, 56–57

Adobe Prelude CC
adding markers with, 131
importing from, 50
using with Media Browser, 50

Index
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Adobe Premiere Pro CC
audio editing, 10
color correction, 10
hardware support, 10
keyframe controls, 10
media encoding, 11
Mercury Playback Engine, 11
metadata, 11
multicam editing, 11
project management, 11
Title Designer, 11
trimming tools, 11

Adobe SpeedGrade CC
described, 12
exporting to, 454
and Lumetri effects, 346
sending clips to, 359

Adobe Story application, described, 
78

Adobe Story panel, accessing, 80–82
After Effects CC. See Adobe After 

Effects CC
alpha channels

explained, 366, 368
transparencies, 371–372

AMA system, using with Avid Media 
Composer, 38

amplitude of audio, explained, 252
anchor points, changing, 211–213
animating text with After Effects, 

415–418
ARI files, settings for, 89
assets

finding in Project panel, 69–71
finding with Media Browser, 

53–55
importing, 48–51
using from other projects, 51

audio. See also EQ effects; noisy 
audio; split edits

bands, 274
locating dialogue, 249
master track output, 246–247
monitoring, 250–251
normalizing, 255–256
overview, 244
Panner control, 253
removing background noise, 

292–294
sampling rate, 249
sending to Audition CC, 255
smoothing out, 274–276
Solo buttons, 250–251
static vs. dynamic peaks, 248
stereo control, 253
viewing samples, 248–249

VU meter, 276
audio channels

adjusting, 87–88
examples, 246
explained, 247
exporting, 449

audio characteristics
amplitude, 252
explained, 251
frequency, 252
phase, 252
waves, 251

Audio Clip Mixer
adjusting pan, 262
described, 246
using, 261–262

audio clips. See also clips
measuring time for, 31–33
unlinking from video, 154

audio display formats, 32
audio distortion, cause of, 253
audio editing, 10
audio effects. See also effects; EQ 

effects; video effects
adding delays, 270–271
adding reverb, 272–273
adjusting bass, 269–270
adjusting pitch, 271
adjusting treble, 272
Bass, 269
Delay, 269
DeNoiser, 269
project file, 268
Reverb, 269
Treble, 269

audio gain, adjusting, 254
audio levels

adjusting for clips, 258
emphasizing parts of, 274–276
explained, 248
Loudness Radar, 269
watching, 269

Audio Master setting, 43
audio meters, using, 247–248
Audio Mixer, 15
audio only, selecting, 136
Audio Plug-in Manager, installing, 

284
audio submixes, 44
Audio Track Mixer

automation modes, 263–264
creating mixes, 278–280
creating submixes, 280–282
described, 246
Effects and Sends, 262
Latch mode, 263–264

Mute setting, 284
Off mode, 263
Pan section, 262
Read mode, 263
Solo setting, 284
Touch mode, 264
volume faders, 262
Write mode, 264

audio track types, 43–44
audio tracks. See also tracks

deemphasizing parts of, 274–276
maximum in Timeline, 102
standard type, 250
submixes, 263

audio transitions. See also transitions
adding, 160–162
crossfades, 161

audio volume, adjusting in Effect 
Controls panel, 252–253. See 
also volume

audio waveforms, showing, 249–250
Audio workspace, 245–246
Audition CC. See Adobe Audition CC
Avid Media Composer projects, 

importing, 37–38

B

background noise, removing, 
292–294

Basic 3D effects
Distance to Image, 226
Specular Highlight, 226
Swivel, 226
Tilt, 226
using, 224–226

bass, adjusting, 269–270
bevels, adding, 221–223
Bezier handles, using with 

transitions, 173
bin content, filtering, 70
bin views

changing, 74–75
Icon view, 74
List view, 74

bins
creating, 72
customizing, 77–78
as folders, 70
managing media in, 73
opening multiple, 79

bit depth, maximum, 42
bitmap vs. vector graphics, 410
blend modes

explained, 368
using with video effects, 309
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Blu-ray, encoding format, 447
Bridge CC, 12
brightness, default for, 21
Broadcast Colors effect, 347
broadcast legalization, 358

C

cameras. See multi-camera editing
captions, adding to sequences, 

454–456
Capture Format settings

DV and HDV capture, 33
third-party hardware capture, 33

CC (Creative Cloud), setting options 
for, 21

Change Clip Speed option, 166
Chromakey composition, making, 

373
clip markers, using, 131
Clip Name effect, using, 323–324
clip size, changing, 214–215
clip vs. track keyframes, 260–261
clipboard, using, 140
clips. See also audio clips; files; 

segments; trimming; video clips
adding rotation, 211–213
adding scene numbers for, 82
adding to Timeline with Program 

Monitor, 122–125
adjusting audio channels, 87–88
Change Clip Speed option, 166
changing anchor points, 211–213
changing duration, 168–173
changing speed, 168–173
copying, 140
creating subclips, 100–101
disabling, 142
displaying metadata for, 81
dragging, 137–138
dragging and dropping, 122
dropping, 139
editing into sequences, 125
lengthening, 184
linking, 137
loading with Source Monitor, 

95–96
making copies of, 73
making offline, 423–424
merging, 88
moving, 137–140
moving with Slip tool, 191
navigating with markers, 131
nudging, 138–139
organizing, 9, 69
pasting to clipboard, 140

previewing in Media Browser, 54
in Project panel, 67
rearranging in sequences, 

139–140
re-enabling, 142
renaming, 77
replacing, 174–178
repositioning, 208–210
repositioning with Motion effect, 

202–207
resizing, 214–215
results of speed changes, 174
retiming, 168–173
rewinding in Media Browser, 54
Scale property, 214
scaling, 103
selecting, 135–136
selecting portions of, 162
selecting ranges in, 97–100
sending to Adobe After Effects, 

311–313
sending to Adobe SpeedGrade, 

359
shortening, 184–185
sorting in Icon view, 114
Speed/Duration command, 

168–170
splitting, 136–137
terminology, 26
trimming to zero duration, 187
unlinking, 137
varying speed of, 171–173
viewing contents of, 82–84
in workspace, 15

closed captioning, using, 454–456
codecs

choosing, 440–441
defined, 42

collaboration, managing, 430
color balance, fixing, 349–356
color correction. See also exposure 

problems
before-and-after comparison, 350
choosing pixels, 354
creating a look, 358–359
evaluating, 349
Fast Color Corrector, 344, 350
fixing overexposed, 349
Lumetri effects, 346
primary, 351–353
RGB Color Corrector, 345
RGB Curves, 345
secondary, 354–356
SpeedGrade, 346
support for, 10

Three-Way Color Corrector, 345, 
354

Color Correction workspace
components, 331
Reference Monitor, 334–341

color effects
broadcast legalization, 358
Change to Color, 357
Leave Color, 356–357
technical, 346–347

color grading. See Adobe SpeedGrade 
CC

color removal, 343–344
color replacement, 343–344
coloring effects

black-and-white, 342
tint, 342

colors
additive and subtractive, 339
choosing for video typography, 

394
phases for working with, 331
primary and secondary, 338

compositing techniques
alpha channels, 364–366, 368
blend modes, 368
considering while shooting, 

366–368
greenscreen, 368
keying, 368
mattes, 368
opacity, 368
terminology, 368

conforming sequences, 103
content analysis, organizing media 

with, 79–82
control point, removing from curve 

control, 348
copying files, 426–427
Crawl option, using with text, 

411–412
credits

rolling, 413
setting, 414

Cross Dissolve effect, using with 
handles, 159

crossfades
Constant Gain, 161
Constant Power, 161
creating for audio transitions, 161
Exponential Fade, 161

curve control, removing control point 
from, 348



Adobe Premiere Pro CC Classroom in a Book  463

D

dB (decibel) scale, 248
delays, adding to audio, 270–271
deleting

clips, 142
render files, 431

dialogue, locating, 249
digital video workflow

enhancing, 10–11
expanding, 11
steps, 9–10

dissolve time
dragging, 158
positioning, 158

dragging
clips, 140
In and Out points, 183
in replacement clips, 174–175

drive setup storage, 35
drop shadows, adding, 220–221
drop zones, displaying for panels, 

18–19
dropping clips, 140
duration. See speed and duration
DV deck, recording to, 457–458
DVD/Blu-ray, encoding format, 447
Dynamic Link. See Adobe Dynamic 

Link
dynamic trimming. See also trimming

J key, 197
K key, 197
L key, 197
Shuttle Left, 197
Shuttle Right, 197
Shuttle Stop, 197

Dynamics effect, using with audio, 
289–291

E

Ease presets, using, 218–220
editing

automated to markers, 132
multicam, 11
from Project panel, 100
storyboard, 113–115
three-point, 112–113

editing techniques. See also trimming
four-point editing, 166–168
nesting sequences, 179–182
project file, 166
replacing clips, 174–178
replacing footage, 174–178
retiming clips, 168–173

editing workflow. See also video 
editing

After Effects CC, 12
Audition CC, 12
Bridge CC, 12
Dynamic Link, 12
Encore CS6, 12
Flash Professional CC, 12
Illustrator CC, 12
Media Encoder CC, 12
Photoshop CC, 12
Prelude CC, 12
SpeedGrade CC, 12

Editing workspace. See also 
workspaces

Audio Master meters, 15
Audio Mixer, 15, 17
clips, 15
customizing, 18–20
default for clips and markers, 120
default for organizing media, 66
default for video editing, 94
Effect Controls panel, 15
Effects panel, 15–16
files, 14–15
History panel, 15, 17
Info panel, 15, 17
Markers panel, 15
Media Browser, 15–16
Preview Area, 68
Program Monitor, 15
Project panel, 15–16
sequence, 15
Source Monitor, 15–16
Timeline, 15–16
Tools panel, 15
tracks, 15–16

edits, snapping to, 111
EDLs (edit decision lists), using, 

452–453
Effect Controls panel, 15

adjusting audio in, 252–253
A/B editing mode, 156–160
changing parameters in, 156–158
expanding width of, 157
fixed effects, 299–301
Scale property of Motion effect, 

214
selecting effects in, 210
trimming in, 158
video options, 305

effects. See also audio effects; video 
effects

applying, 305–307
Clip Name, 323–324

comparing, 223–224
finding, 342
frequently used, 321–326
image stabilization, 321–323
rendering, 305
reordering, 305
rolling shutter reduction, 

321–323
Shadow/Highlight, 325–326
Timecode, 323–324
Warp Stabilizer, 321–323

Effects Browser
32-bit color effects, 304
accelerated effects, 303
using, 301–303
YUV effects, 304

Effects panel, 15
effects presets

built-in, 318–319
saving, 319–321

encoding formats
devices, 447
DVD/Blu-ray, 447
user-generated video sites, 447

Encore CS6, 12
EQ effects. See also audio effects

Parametric, 276–277
standard, 274–276

essence, defined, 42
export options, 436
exporting

to AAF (Advanced Authoring 
Format), 452

to Adobe SpeedGrade, 454
channels of audio, 449
Final Cut Pro XML files, 450
master copies, 439–441
to OMF (Open Media 

Framework), 451
single frames, 437–438
XML files from Final Cut Pro 

7, 36
exports. See also Adobe Media 

Encoder CC
configuring, 444–446
queuing, 448–449

exposure problems, fixing, 347–349. 
See also color correction

extra edit, performing, 142
eyedropper controls, using, 354

F

F4V format, using, 447
face detection, turning on, 82
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File menu
Clip menu, 423
commands, 423
making clips offline, 423–424
Remove Unused command, 423

file-based workflow. See tapeless 
workflow

files. See also clips; raw files; render 
files

copying, 426–427
locating, 14

Final Cut Pro projects, importing, 36
Final Cut Pro XML files, exporting, 

450
Find button, using in Project panel, 

71
fixed effects

processing, 306
using, 299–301

Flash development, encoding 
formats, 447

Flash Professional CC, 12
flattened Photoshop files, importing, 

56–57
float processing, 304
FLV format, using, 447
folders, bins as, 70
fonts, choosing for video typography, 

393
footage

interpreting, 89
monitoring, 82–86
playback resolution, 84
replacing, 174–178
safe margins, 84–85
timecode information, 84

four-point editing
Change Clip Speed option, 166
implementing, 167–168
as mistake, 166
options, 166–167

frames
exporting, 437–438
recognizing duplicates, 174
and seconds, 32
toggling to full-screen, 95

frequency of audio, explained, 252. 
See also audio; noisy audio

G

gain
adjusting for audio, 254
vs. volume, 254

gaps, finding in Timeline, 134
GPUs (graphical processing units)

and accelerated effects, 303
using multiple, 321

graphics
adding to titles, 410–411
creating in Adobe Photoshop, 

406–407
vector vs. bitmap, 410

grayscale, defined, 364
greenscreen shots

color keying, 372–376
explained, 368
preprocessing footage, 374
Ultra Key effect, 374–376

H

H.264 format, using, 447
handles

head and tail, 158–160
using with video clips, 149

hard drives, managing, 430
hardware support, 10
HDV deck, recording to, 457–458
head and tail handles, dealing with, 

158–160
high-bit-depth, 304
Highpass effect, using with noisy 

audio, 285–286
History panel, 15, 17
hover scrub feature, using, 82–84

I

Icon view, sorting clips in, 114
Illustrator. See Adobe Illustrator CC
image stabilization, 321–323
images. See also still images

fixing underexposed, 348
importing, 55–58
rotoscoping foreground, 384

Import command, using, 48–49
importing

AAF files, 38
from Adobe Prelude, 50
assets, 48–51
Avid Media Composer projects, 

37–38
Final Cut Pro 7 XML files, 37
Final Cut Pro projects, 35–36
flattened Photoshop files, 56–57
Illustrator files, 58
images, 55–58
layered Photoshop files, 56–57
projects, 429
sequences, 429
sequences directly, 449

In and Out points. See also Out 
points

adding on Timeline, 107
clearing, 107
dragging in Source Monitor, 183
marking in Source Monitor, 

182–183
slip edits, 190–191
using in Source Monitor, 106–107
using slide edits with, 188

inertia, adding feeling of, 218–220
Info panel, 15, 17
insert edit

performing in Timeline, 110–112
with Program Monitor, 123–125

interpolation, temporal vs. spatial, 216

J

J-cuts, adding, 257
jump cut, explained, 148

K

keyboard shortcuts. See also modifier 
keys

Add Edit, 137
audio transitions, 162
copying clips to clipboard, 140
dragging clips, 140
dropping clips, 140
exporting media, 440
for making subclips, 101
for markers, 130
nudging clips, 139
opening titles, 408
pasting clips to clipboard, 140
Undo command, 169

keyframe controls, 10
keyframe interpolation

adding Ease to motion, 218–220
adding to video effects, 315–317
Auto Bezier, 217, 318
Bezier, 217, 318
Continuous Bezier, 217, 318
Ease In, 318
Ease Out, 318
Hold, 217, 318
Linear, 318
linear, 217
methods, 318

keyframes
adding to video effects, 314–315
controlling, 315
ramping, improving with Bezier 

handles, 171–173



Adobe Premiere Pro CC Classroom in a Book  465

selecting precisely, 205
spatial interpolation, 216
temporal interpolation, 216
terminology, 216

keying, process of, 368

L

labels, assigning in Project panel, 76
lasso, using to select clips, 135
layered Photoshop files, importing, 

56–57
layers

animating with After Effects, 416
basing on blend modes, 370–371
combining, 370–371

L-cuts, adding, 257
leading, choosing for video 

typography, 396–397
levels, adjusting, 352
Lift control, using, 141
light, reflecting off rotated surface, 

224
locks. See sync locks
logos, aligning in titles, 411–412
Loop button, accessing in Source 

Monitor, 86
Loudness Radar, using with audio 

levels, 269
Lowpass effect, using with noisy 

audio, 285–286
Lumetri effects, 346

M

markers
adding, 131
automated editing to, 132
Chapter Marker, 129
clips, 131
Comment Marker, 129
described, 128
Flash Cue Point, 129
interactive, 131
keyboard shortcuts, 130
removing all, 131
sequence, 129–130
syncing with, 232
Web Link Marker, 129

Markers panel
displaying, 130
locating, 15

master copies, exporting, 439–441
mattes

customizing with Titler, 380–381
explained, 368

garbage type, 377
generating, 377–383
with graphics, 379
with other clips, 379
Track Matte Key effect, 379
traveling type, 382–383

media
finding, 73
managing in bins, 73
organizing with content analysis, 

79–82
Media Browser

benefits, 51
enlarging, 53
enlarging thumbnails, 54
finding assets with, 53–55
locating, 15
positioning onscreen, 51
previewing clips, 54
rewinding clips, 54
selecting clips in bin, 54
stopping playback, 54
tapeless workflow, 51–52
using, 49–51
video file types, 52

media cache
benefits, 61
cleaning, 62
moving, 62

Media Composer projects, 
importing, 37–38

Media Encoder. See Adobe Media 
Encoder CC

media encoding, 11
media management, 431
Mercury Playback Engine, 11

64-bit and multithreading, 31
CUDA support, 31
Engine Software Only, 30
GPU Acceleration option, 30
graphics cards, 31
Open CL support, 31
playback performance, 31

metadata
displaying for clips, 81
support for, 11

modifier keys, using for trimming, 
196. See also keyboard shortcuts

monitors, customizing, 86
Motion effect, adjusting, 202–207
Motion settings

Anchor Point, 203
Anti-flicker Filter, 204
Position, 203
Reset button, 208
reusing, 210–211

Rotation, 203
Scale, 203
Scale Width, 203
seeing bounding box easily, 

206–207
selecting keyframes precisely, 205
using, 206–208

motion-related effects
3D space, 224–226
bevels, 221–223
drop shadows, 220–221
Transform effect, 223–224

movement, creating with Basic 3D 
effect, 224–226

MPEG2 format, using, 447
Multiband Compressor effect, using 

with audio, 286–288
multi-camera editing

action scenes, 230
adding clips to source sequence, 

233–234
audio, 232
changing edits, 237
clip markers, 232
creating sequences, 231–235
creating target sequence, 235
finalizing, 238–239
flattening, 239
musical performances, 230
once-in-a-lifetime events, 230
Out points, 232
In points, 232
process, 231
project file, 230
re-recording, 237–238
special effects, 230
support for, 11
switching angles, 238
sync points, 232
talk-show formats, 230
theatrical performances, 230
timecode, 232
uses of, 230
visual effects, 230

multiple cameras, 235–237
enabling recording, 235–237
switching, 235–238

N

nested sequences. See also sequences
changing, 182
creating, 179–181
opening, 182
uses, 179

network-based storage, 35
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NLE (nonlinear editing)
digital video workflow, 9–10
Premiere Pro as, 8

noisy audio. See also audio; frequency 
of audio

Dynamics effect, 289–291
Highpass effect, 285–286
Lowpass effect, 285–286
Multiband Compressor effect, 

286–288
removing from background, 

292–294
normalizing audio, 255–256
Notch effect, using with audio, 289

O

offline vs. online clips, 423
OMF (Open Media Framework), 

exporting to, 451
opacity

defined, 368
keyframing, 369–370

Opacity effect, using, 368–371
Out points, adding to Timeline, 113. 

See also In and Out points

P

panel layouts, saving, 20
panels

drop zones, 18–19
moving, 18–19

paragraph text, adding to titles, 
401–403

Parametric EQ, 276–277
Paused Resolution option, using, 127
phase of audio, explained, 252
photo montage, applying transitions 

to, 153–154
Photoshop. See Adobe Photoshop CC
PIP clips, managing, 175
pitch, adjusting, 271
playback controls

navigator, 85
Play button, 85
playhead, 85
Step Back button, 85
Step Forward, 85
time ruler, 85
using, 85–86
Zoom, 86

playback resolution
controlling, 126
switching, 84

playback settings, 28–30

playhead, snapping to edits on 
Timeline, 111

point text, using with titles, 399–401
preferences

setting for workspaces, 21
sharing, 21
syncing on Welcome screen, 21

Prelude. See Adobe Prelude CC
Premiere Pro. See Adobe Premiere 

Pro CC
presets. See effects presets
primary correction, implementing, 

351–353
Program Monitor

adding clips to Timeline, 122–125
choosing trim types, 195
current sequence frame, 121
dragging and dropping clips, 122
Extract control, 121
features, 120–121
insert editing, 123
Lift control, 121
locating, 15
Mark In control, 121
Mark Out control, 121
regular trim, 192
ripple trim, 192
roll trim, 192
settings, 121
vs. Source Monitor, 121
Trim mode, 192–193
trimming in, 192–195
trimming methods, 194–195
zoom bar on, 108

project files
browsing, 49–50
choosing locations for, 35
settings, 34–35

project management, 11
Project Manager

collecting files, 426–427
copying files, 426–427
Exclude Unused Clips, 425
Include Audio Conform Files, 425
Include Handles, 425
Include Preview Files, 425
Link Media panel, 427–428
Locate command, 427–428
Make Offline, 425
Project Destination, 425
Rename Media Files, 425
Resulting Project, 425
Source option, 425
trimmed projects, 426

Project panel
assigning labels, 76

Bin button, 72
clips, 67
customizing, 67–68
displaying items in, 69
editing from, 100
filtering bin content, 67, 70
Find button, 67, 71
finding assets in, 69–71
finding blank parts of, 72
headings, 67
Icon view, 67
List view, 67
locating, 15
Media Duration heading, 69
New bin button, 67
organizing clips, 69
renaming clips, 77
scrolling in, 69
sequences, 67
Sort icons, 67
Thumbnails option, 74–75
toggling to full screen, 67
Zoom control, 67, 74–75

projects
creating, 27–28
importing, 429
playback settings, 28–30
video rendering settings, 28–30

.prproj extension, 15
PSD Files bin, using, 73

R

R3D files, settings for, 89–90
ramping, improving with Bezier 

handles, 173
Rate Stretch tool, accessing, 170–171
raw files, working with, 89–90. See 

also files
Razor tool, splitting clips with, 136
real-time playback, 28–29
recording

to DV deck, 457–458
to HDV deck, 457–458
scratch narration track, 59–60
to tape, 456–458

RED media, resource for, 90
Reference Monitor

combination views, 341
Gang to Program Monitor, 

334–335
RGB parade, 339
vectorscope, 337–338
YC waveform, 335–337
YCbCr parade, 340

regular trim, explained, 183
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render files, deleting, 431. See also 
files

render quality, maximum, 42
rendering

effects, 305
explained, 29–30

replace edits, making, 175–177
Replace Footage feature

caution about, 178
using, 177–178

resizing clips, 214–215
resolution, controlling, 125–127
reverb, adding to audio, 272–273
Reverb effect, using with submix, 

282–284
RGB Color Corrector, 345
RGB parade, accessing, 339
ripple deleting clips, 142
Ripple Edit tool

using for trimming, 184–186
using with handles, 159

ripple trim, performing in Program 
Monitor, 192

roll trim, performing in Program 
Monitor, 192

Rolling Edit tool, using with 
transitions, 160

rolling edits
applying, 257
using for trimming, 187

rolling shutter reduction, 321–323
rolling text, 411–414
rotation, adding to clips, 211–213
Roto Brush tool, After Effects, 384
rough cut, building from storyboard, 

114
rubber band, adjusting, 369

S

Safe Margins setting, choosing, 
84–85

Safe Title Margin option, choosing, 
398

saturation, adjusting, 353
saving

custom styles for titles, 405
effects presets, 319–321
panel layouts, 20

Scale property, using with clips, 214
scene numbers, adding for clips, 82
Scratch Disks settings, 34
scratch narration track, recording, 

59–60. See also tracks
scrolling options, 105
scrubbing, defined, 108

secondary correction
explained, 351
implementing, 354–356

seconds and frames, 32
segments. See also clips

deleting, 142
extracting, 142
ripple deleting, 142

Selection tool, using with clips, 135
sequence markers, adding, 129–130
sequence settings, matching, 

439–440
sequences. See also nested sequences; 

Timeline panel
audio tracks, 104
choosing presets, 39–41
conforming, 103
creating, 26, 103
creating for multi-camera editing, 

231–235
creating to match sources, 38–39
customizing, 41–42
defined, 103
display changes, 155
frame size, 40
frames per second, 40
importing, 429
importing directly, 449
locating, 15
navigating with markers, 131
nesting, 179–182
opening in Source Monitor, 104
in Project panel, 67
removing parts of, 141
reusing, 179
trimming in, 183–184
video tracks, 104

Shadow/Highlight effect, using, 
325–326

shapes
aligning in titles, 411–412
creating for titles, 408–410

Shift key. See keyboard shortcuts
Silverlight deployment, encoding 

format for, 447
Slide Edit tool, using for trimming, 

188–189
Snap button, using to drag clips, 

137–138
Solo buttons, using with audio, 

250–251
sounds. See audio
Source Monitor, 15. See also video 

editing
active frame, 95
Add Marker control, 97

adding buttons, 86
controls, 97
Go to In control, 97
Go to Out control, 97
Insert control, 97
loading clips, 95–96
Loop button, 86
Mark In control, 97
Mark Out control, 97
opening sequences in, 104
In and Out points, 106–107
Overwrite control, 97
vs. Program Monitor, 121
removing buttons, 86
selecting ranges in clips, 97–100
Settings button, 86
toggling to full-screen frames, 95
tool tips, 98
trimming in, 182–184
using, 94–95

source tracks, moving indicators for, 
106

spatial interpolation, 216
specular highlight, enabling, 224–225
Speech to Text function, 80–82
speed and duration

changing, 168–170
Rate Stretch tool, 170–171
time remapping, 171–173

speed changes, impact on clips, 174
Speed/Duration command

accessing, 169
Maintain Audio Pitch option, 170
for multiple clips, 170

SpeedGrade. See Adobe SpeedGrade 
CC

split edits. See also audio; video
adding J-cuts, 257
adding L-cuts, 257
creating, 257

splitting clips, 136–137
Stabilization method options

Method, 322
Result, 322
Smoothness, 323
using with effects, 322–323

still images, setting duration for, 114. 
See also images

storage
drive setup, 35
network-based, 35
for video editing, 34

storyboard editing, 113–115
subclips

creating, 100–101
keyboard shortcut, 101
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submixes
applying effects to, 282–284
vs. audio tracks, 263
choosing, 44
creating, 280–282
purpose, 278, 280

subtractive color, explained, 339
sweetening sound. See audio effects
sync locks, using, 133–134
Sync Settings menu, displaying, 21
syncing with markers, 232

T

tail and head handles, dealing with, 
158–160

tape
AES and XLR audio, 458
component video, 458
preparing for output, 457
recording to, 456–458
RS-422 deck control, 458
SD/HD-SDI, 458
vs. tapeless workflow, 62
third-party hardware, 458

tape formats, support for, 8
tape output, preparing projects for, 

457
tape vs. tapeless workflow, 62
tapeless formats, support for, 8, 52
tapeless workflow, using with Media 

Browser, 51–52
temporal interpolation, 216
text

animating with After Effects, 
415–418

positioning, 399
rolling, 411–412

Theft Unexpected bin
displaying, 103
Metadata Display option, 77
opening, 77

three-point editing, 112–113
Three-Way Color Corrector, 345, 354
thumbnails, displaying in Project 

panel, 74–75
time remapping

removing effects, 173
using, 171–173

time rulers, using, 108
timecode, entering directly, 98
timecode display, locating, 84, 97
Timecode effect, using, 323–324
Timeline panel. See also sequences

Add Marker control, 102
adding In and Out points, 107

clip audio, 102
clip video, 102
display settings, 102
features, 101–102
finding gaps in, 134
locating, 15
mute audio, 102
navigating, 101–102
number of audio tracks, 102
number of video tracks, 102
performing insert edit, 110–112
playhead, 102
resizing tracks, 102
sequence nest toggle, 102
shortcut, 107
snap, 102
solo audio, 102
source tracks, 102
sync lock, 102
time ruler, 102
timecode, 102
track lock, 102
track output, 102
track selection, 102
tracks, 102
trimming in, 183–184, 198
zooming in and out of, 102

Title Designer, 11
Titler

applying transitions to, 392
changing font size, 391
customizing mattes with, 

380–381
Font Family menu, 390
Front Browser menu, 390
opening, 388
panels, 389, 391–392
rolling text, 413–414
selecting text, 390
Title Styles panel, 390

titles
adding graphics, 410–411
aligning logos, 411–412
aligning shapes, 411–412
bumpers, 388
changing appearance of, 403–404
creating, 398–403
creating in Adobe Photoshop, 

406–407
creating shapes, 408–410
IDs, 388
lower-third, 388
opening, 408
paragraph text, 399, 401–403
point text, 399–401
saving custom styles, 405

text on path, 399
Typographic Properties panel, 

404
using in other projects, 393
video typography, 393–398
wrapping text, 400

tool tips, using with Source Monitor, 
98

Tools panel, 15
track headers

customizing, 108–109
using, 105

track locks, using, 134
Track Select tool, using, 136
track vs. clip keyframes, 260–261
tracks. See also audio tracks; scratch 

narration track; video tracks
features, 104–105
locating in Timeline, 15, 102
output in Timeline, 102
selecting in Timeline, 102
targeting, 105–106

Transform button, uses of, 206
Transform effect, using, 223–224
transitions. See also audio transitions; 

video transitions
applying to multiple clips, 

153–154
applying to titles, 392
avoiding overuse of, 148
best practices, 147–148
changing duration of, 162
copying between sequences, 151
dragging and replacing, 152
Duration and Alignment controls, 

158
edit points, 148–149
explained, 146–147
fine-tuning with A/B mode, 

156–160
handles, 148–149
jump cuts, 148
project file, 146
Rolling Edit tool, 160
smoothing out, 173
using, 147

treble, adjusting, 272
Trim mode

B side, 192, 194
A side, 192, 194
using in Program Monitor, 

192–193
Trim Monitor, accessing, 192
trimmed projects, working with, 426
trimming. See also clips; dynamic 

trimming; editing techniques
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backward, 198
defined, 158
forward, 198
with keyboard, 198
preroll and postroll times, 196
in Program Monitor, 192–195
Ripple Edit tool, 184–186
rolling edits, 187
in sequences, 183–184
Slide Edit tool, 188–189
sliding clip selections, 198
slipping clip selections, 198
in Source Monitor, 182–184
in Timeline, 183–184
using slip edits, 190–191

trimming methods, choosing in 
Program Monitor, 194–195

trimming selections, refining, 196
trimming tools, 11
Type tool, using, 397
Typographic Properties panel

Color tool, 404
Fill Type tool, 404
Shadow tool, 404
Sheen tool, 404
Stroke tool, 404

typography. See video typography

U

Ultra Key effect
disabling, 377
using with greenscreen shots, 

374–376
underexposed images, fixing, 348
Undo command, keyboard shortcut, 

169
user interface elements. See Editing 

workspace

V

vector graphic, importing from 
Illustrator, 58

vector vs. bitmap graphics, 410
vectorscope, using, 337–338
velocity, adding to video effects, 

315–317
video. See also split edits

8-bit, 352
acquiring, 9
capturing to hard drive, 9

video cards, using with effects, 303
video clips. See also clips

measuring time for, 31–33
unlinking from audio, 154

Video Display Format options, 31–32
video editing, storage for, 34. See 

also editing workflow; Source 
Monitor

video effects. See also audio effects; 
effects

adding keyframe interpolation, 
315–317

adding keyframes, 314–315
adding velocity, 315–317
adjustment layers, 307–310
applying, 305–307
blending, 309
Effects Browser, 301–304
fixed, 299–301, 306
locating, 303
position-related parameters, 316
toggling on and off, 306

video levels, adjusting, 352
Video Limiter, 346, 358
video only, selecting, 136
video rendering settings, 28–30
video scopes, using, 333
video tracks. See also tracks

maximum in Timeline, 102
splitting into subtracks, 156–160

video transitions. See also transitions
adding, 149–154
applying between clips, 151–153
single-sided, 150
third-party effects, 149

video typography
alignment, 397
color choices, 394
font choices, 393
leading, 396–397

video workflow, 9–10, 13
videos, viewing on second monitor, 

96
volume. See also audio volume

vs. gain, 254
smoothing between keyframes, 

259
volume changes, keyframing, 259
VST plug-ins, using with audio, 273

W

Warp Stabilizer effect, using, 
321–323

websites
Adobe Audition CC, 255
RED media, 90
YUV effects, 304

white balance, 350
Windows Media format, using, 447

workflow. See editing workflow; tape 
vs. tapeless workflow; video 
workflow

workspaces. See also Editing 
workspace

preferences, 21
returning to default layouts, 20
storing, 18–20

wrapper, defined, 42

X

XML files, exporting, 450

Y

YC waveform, 335–337
YCbCr parade, accessing, 340
YUV effects, using with video, 304

Z

Zoom control
adjusting in Project panel, 74–75
identifying, 67
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